
 Σελίδα 1  

Δημιουργώντας γραφικά στο περιβάλλον Blender 

Έχοντας εξοικειωθεί με το περιβάλλον εργασίας του λογισμικού Blender, είμαστε σε θέση να ξεκινήσουμε 

να επεξεργαζόμαστε τις πρώτες δημιουργίες μας. Στην άσκηση αυτή θα γνωρίσουμε βασικά εργαλεία για τη 

σχεδίαση ενός απλού χαρακτήρα και την αναπαραγωγή ενός βασικού animation με πρωταγωνιστή αυτό το 

χαρακτήρα. 

 

Πρώτα βήματα 
 

Με την εκκίνηση του προγράμματος βλέπουμε τη βασική οθόνη εργασίας, όπως την έχουμε αναλύσει σε 

προηγούμενα μαθήματα. Θα πρέπει να έχουμε επιλέξει την 3D view απεικόνιση για επεξεργασία και να 

είμαστε σε θέση να βλέπουμε το αντικείμενο σχεδίασης τοποθετημένο στους τρεις άξονες συντεταγμένων, 

την κάμερα και την πηγή φωτός. 
 

 
Θα ξεκινήσουμε οργανώνοντας την περιοχή εργασίας σε διαφορετικά επίπεδα (layers). Οι τρισδιάστατες 

σκηνές μπορούν να γίνουν πολύπλοκες όταν υπάρχουν αρκετά αντικείμενα, τα οποία πιθανώς και να 

αλληλεπικαλύπτονται, σε ένα επίπεδο. Χρησιμοποιώντας layers μπορούμε ανά πάσα στιγμή να 

αποκρύπτουμε αντικείμενα από την κύρια σκηνή και να τα εμφανίζουμε όταν τα χρειαζόμαστε. 

 

    Εργαλειοθήκη ελέγχου ορατότητας επιπέδων 

Το πρόγραμμα Blender μας "προσφέρει" μέχρι 20 επίπεδα για να οργανώσουμε το σχέδιό μας κι η 

αντίστοιχη εργαλειοθήκη μάς επιτρέπει να γνωρίζουμε ποια επίπεδα είναι ορατά και ποια όχι. Για να 

κάνουμε ορατό ή να αποκρύψουμε ένα layer χρησιμοποιούμε το αριστερό κλικ του ποντικιού (LMB ) και 

για να επιλέξουμε περισσότερα από ένα layers το συνδυασμό Αριστερό SHIFT και αριστερό κλικ(⇧ 
ShiftLMB ). Τα ορατά επίπεδα επισημαίνονται στην αντίστοιχη εργαλειοθήκη με πιο σκούρο γκρι χρώμα. 

Το τελευταία ορατό επίπεδο γίνεται αυτόματα και το ενεργό επίπεδο (active layer). 
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Αρχικά, ας καθαρίσουμε τη σκηνή μεταφέροντας την κάμερα και την πηγή φωτός σε άλλο layer. 

 

 

Το παράθυρο μετακίνησης επιπέδων (Move to Layer) 
 
 

 
Επιλέξτε την κάμερα, κάνοντας δεξί κλικ πάνω της (RMB ). Στην επιλογή προσθέστε και τη λάμπα 

πατώντας το συνδυασμό SHIFT + δεξί κλικ (Shift+RMB ). Πατήστε το πλήκτρο M (Move) και η μικρή 

εργαλειοθήκη του παραπάνω σχήματος θα εμφανιστεί κάτω από το δείκτη του ποντικιού με ενεργή επιλογή 

το πρώτο layer. Μετακινείστε τα δύο αντικείμενα (την κάμερα και τη λάμπα) στο επίπεδο 10, πατώντας στο 

άκρο δεξιά κουμπί της εργαλειοθήκης Move to Layer. Κάντε ορατό μόνο το πρώτο επίπεδο. 
 

Σημείωση: Οι συντομεύσεις πληκτρολογίου είναι πολύ βοηθητικές κατά τη χρήση του λογισμικού Blender. Για να μπορέσουν 

να εμφανιστούν οι αντίστοιχες λειτουργίες θα πρέπει ο δείκτης του ποντικιού να είναι εντός της σκηνής και η επιλογή θέασης 

να είναι η 3D view για το αντίστοιχο frame στο οποίο δουλεύουμε. 

 

 
 

Σχεδιάζοντας το σώμα του χαρακτήρα 
 

Έχοντας ενεργό το αριθμητικό πληκτρολόγιο, αλλάξτε τη γωνία θέασης σε Front View πατώντας το 

πλήκτρο 1 (1 NumPad) και σε ορθογραφική προβολή (orthogonal view) πατώντας το πλήκτρο 5 (5 

NumPad). Στην πάνω αριστερή γωνία του 3D παραθύρου μπορείτε να διακρίνετε αν είστε σε ορθογραφική 

(orthogonal) ή προοπτική (perspective) προβολή. 

 

 

 

 
Μετακίνηση κέρσορα στο κέντρο 

 
 
 
 
 
 

 
Αν δεν εμφανίζεται ένας κύβος στη σκηνή πρέπει να δημιουργήσουμε ένα. Τοποθετείστε το δείκτη του 

ποντικιού στο κέντρο του συστήματος συντεταγμένων (σημείο 0,0,0) επιλέγοντας Object » Snap » Cursor 

to Center ή χρησιμοποιώντας τη συντόμευση πληκτρολογίου ⇧ Shift+S . 
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Για να προσθέστε ένα κύβο στη σκηνή επιλέγετε Add » Add 

Mesh » Cube ή χρησιμοποιείτε τη συντόμευση ⇧ Shift+A. 

Στη σκηνή θα εμφανιστεί ένας κύβος με πορτοκαλί χρώμα, 

το οποίο σημαίνει ότι είναι και το ενεργό αντικείμενο. Για 

να "εισέλθετε" σε Edit Mode πατήστε το πλήκτρο ⇆ Tab. 

Στην κατάσταση Edit Mode μπορούμε να επεξεργαστούμε 

τις κορυφές του δικτύου ακμών (mesh). Ως προεπιλογή, όλες 

οι κορυφές είναι επιλεγμένες για κάθε νέο αντικείμενο το 

οποίο εισάγετε στη σκηνή και χρωματίζονται με το 

χαρακτηριστικό πορτοκαλί χρώμα. Στην κατάσταση Object 

Mode, οι κορυφές δεν είναι ούτε επιλέξιμες ούτε 

διαχειρίσιμες. 

 

 
 

Θα ονομάσουμε το χαρακτήρα μας "Gus". Για να το 

επιτύχουμε αυτό, μετακινούμαστε στην επιλογή object- 

context, η οποία βρίσκεται στο Properties Window στη 

δεξιά μεριά της σκηνής. 
 

 

 

 

 
 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
 
 

 

 

 

 
 

ΑΝΕΝΕΡΓΟ. 

Τμήμα της εργαλειοθήκης Tool Shelf 

 
Η πρώτη μέριμνα είναι να σχεδιάσουμε το "σώμα" του χαρακτήρα μας, 

κάνοντας επεξεργασία στις κορυφές (vertices) του κύβου. Τα εργαλεία 

που θα χρειαστούμε βρίσκονται στην εργαλειοθήκη Tool Shelf, η οποία 

είναι τμήμα του 3D Window (στην αριστερή μεριά της οθόνης). Αν η 

εργαλειοθήκη Tool Shelf δεν είναι εμφανής, απλά πατήστε το πλήκτρο T. 

 

Εντοπίστε το κουμπί Subdivide (κάτω από την επιλογή Add) και πατήστε 

το μία φορά. Με την ενέργεια αυτή, κάθε πλευρά του κύβου θα χωριστεί 

σε δύο τμήματα, δημιουργώντας έτσι νέες κορυφές και προσόψεις. Ως 

αποτέλεσμα, θα έχουμε το σχήμα της διπλανής εικόνας. Για να έχετε αυτή 

την όψη , μεταβείτε σε προοπτική προβολή πατώντας το πλήκτρο 5 

(Num5) και περιστρέψτε τη θέα κάνοντας κλικ και σέρνοντας με το 

μεσαίο πλήκτρο του ποντικιού(MMB ). Επιστρέψτε στην προηγούμενη 

όψη με τα πλήκτρα Num1 (Front View) και Num5 (Orthographic). 

 

Με το δείκτη του ποντικιού εντός του 3D window, πατήστε το πλήκτρο A 

για να απεπιλέξτε όλα τα στοιχεία του κύβου, οπότε και οι κορυφές θα 

γίνουν από πορτοκαλί μαύρες. 

Για να συνεχίσετε στην άσκηση, θα πρέπει να έχετε το κουμπί Limit Selection to Visible 
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Τώρα, πατήστε B για να ενεργοποιήστε την επιλογή Box Select/Border Select, οπότε κι ο δείκτης θα 

μετατραπεί σε ένα ζεύγος ορθογώνιων γκρι γραμμών. Μετακινείστε το δείκτη πάνω από την πάνω αριστερή 

γωνία του κύβου, πατήστε και κρατήστε πατημένο το αριστερό πλήκτρο του ποντικιού ( LMB ), σύρετε 

το ποντίκι προς τα κάτω και δεξιά ώστε το γκρι ορθογώνιο να καλύψει όλες τις κορυφές της αριστερής 

πλευρά, όπως φαίνεται στο σχήμα. Αφήστε τώρα το αριστερό πλήκτρο του ποντικιού . 
 

 

 

 

 
 

Πατήστε X ή Delete, οπότε και εμφανίζεται το μενού Vertices και σβήστε τις 

επιλεγμένες κορυφές. 
 

 

 

 

 

 
 

 

 
 

Επιλογή ορατότητας Behavior and Limit Selection  

Όταν βρισκόμαστε σε ορθογραφική προβολή, ίσως υπάρχουν κορυφές κρυμμένες πίσω από άλλες. Με το δεξί κλικ (RMB  

) επιλέγετε μόνο μία από αυτές τις συγκεντρωμένες κορυφές, ενώ το ορθογώνιο επιλογής τις επιλέγει όλες, όσο η μέθοδος 

απεικόνισης Bounding Box ή Wireframe είναι επιλεγμένες. Αν η μέθοδος απεικόνισης του αντικειμένου είναι Solid ή 

Textured, το κουμπί Limit Selection to Visible  πρέπει να είναι ανενεργό, αλλιώς μόνο οι ορατές κορυφές μπορούν να 

επιλεγούν. 

 
 

Ένα άλλο εργαλείο επιλογής κορυφών είναι το Circle Select, το οποίο ενεργοποιείται πατώντας το πλήκτρο 

C. Όταν το εργαλείο Circle Select tool είναι ενεργό, πατώντας και σέρνοντας το αριστερό πλήκτρο επιλέγει 

κορυφές, το μεσαίο πλήκτρο τις απεπιλέγει, η ροδέλα αλλάζει το μέγεθος του κύκλου επιλογής και το δεξί 

πλήκτρο ή το ENTER ολοκληρώνει την επιλογή κι εξέρχεται της κατάστασης Circle Select . 
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Μοντελοποίηση καθρέφτη (Mirror modelling) 

 
Για να μοντελοποιήσουμε συμμετρικά αντικείμενα μπορούμε να χρησιμοποιήσουμε τον τροποποιητή 

καθρέφτη (Mirror modifier), ώστε μόνο μία πλευρά-όψη του χαρακτήρα μας να σχεδιαστεί από εμάς και το 

Blender να δημιουργήσει την άλλη σε πραγματικό χρόνο. Οι τροποποιητές (Modifiers) βρίσκονται στο 

παράθυρο Properties editor. 

 
Το περιεχόμενο της εργαλειοθήκης Modifiers 

 
Προς το παρόν, το περιεχόμενο της 

εργαλειοθήκης είναι κενό. Επιλέγοντας το 

κουμπί με το ¨γαλλικό κλειδί¨ και πατώντας 

Add Modifier, εμφανίζεται μία λίστα από 

μετασχηματισμούς, από τους οποίους 

επιλέγετε Mirror. 

 

 

 

 

 

 

 

 

 

 

 

 
Κουμπί Cage Mode . 

 
Εκτός από τη χρησιμότητα να επεξεργαζόμαστε αντικείμενα 

χωρίς να "καταστρέφουμε" τις ιδιότητές τους, οι modifiers 

επιτρέπουν επίσης τον έλεγχο της πληροφορίας που 

εμφανίζεται όταν δουλεύουμε με αυτούς. Επιλέξτε το κουμπί 

Cage Mode ώστε να μπορέσετε να δείτε τις διαφανείς 

καθρεπτισμένες όψεις στην κατάσταση Edit Mode. Στη 

συνέχεια επιλέξτε τον άξονα "καθρεφτίσματος" του χαρακτήρα 

μας (στην περίπτωσή μας ο Χ άξονας). Το κουμπί Merge θα 

συνενώσει κάθε καθρεφτισμένη κορυφή που είναι σε 

μικρότερη ή ίση απόσταση από αυτή που έχει καθοριστεί στην 

μπάρα Merge Limit. Τα όρια τιμών ποικίλλουν από 0.000 ως 1.000 μονάδες και η επιλεγόμενη τιμή 

εξαρτάται από τη φύση και την κλίμακα κάθε σχεδίου. Για τη σχεδίαση του "Gus", κάθε κορυφή σε 

απόσταση μεγαλύτερη από 0.1 μονάδες από το επίπεδο καθρεφτίσματος θα είναι παρατηρήσιμη και 

ο,τιδήποτε κοντινότερο δεν θα είναι ορατό. Ορίστε το Merge Limit στην τιμή 0.1. 

 

 
 

Τέλος, με ενεργό το κουμπί Clipping, το επίπεδο καθρεφτίσματος γίνεται όριο το οποίο 

καμία κορυφή δεν μπορεί να ξεπεράσει και κάθε κορυφή του επιπέδου παραμένει 

κολλημένη σε αυτό. 
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Χέρια και πόδια 

 
Στο σημείο αυτό θα δημιουργήσετε τα χέρια και τα πόδια του Gus! Χρησιμοποιώντας τα παραπάνω βήματα,  

εφαρμόστε Box Select στις δύο πάνω δεξιά κορυφές (μακραίνοντας το χέρι σε δύο βήματα), το οποίο στην 

ουσία θα επιλέξει τις άλλες 4 κορυφές πίσω από αυτές σε σύνολο 6 κορυφών. Πατήστε το E για να 

προεκτείνετε το επιλεγμένο τμήμα (ή χρησιμοποιήστε το κουμπί Extrude Region της εργαλειοθήκης Tool 

Shelf). Αυτή η ενέργεια θα δημιουργήσει κινούμενες κορυφές και όψεις, τις οποίες μπορείτε να κινείτε με 

το ποντίκι. Μετακινείστε τις κορυφές 1,5 τετράγωνο προς τα δεξιά και κάντε αριστερό κλικ για να 

σταθεροποιήστε τη θέση τους. Μετακινείστε τις κορυφές με το πλήκτρο Ε άλλο μισό τετράγωνο ώστε να 

έχετε το αποτέλεσμα του παρακάτω σχήματος. 
 

Undo/Redo 

 
Το Blender διαθέτει δύο Undo επιλογές, μία για την κατάσταση Edit και μία για την κατάσταση Object. 

 

Στην κατάσταση Edit πατήστε το συνδυασμό Ctrl+Z για αναίρεση επαναληπτικά μέχρι να φτάσετε στο 

επιθυμητό σημείο. Ο συνδυασμός ⇧ Shift+Ctrl+Z επαναφέρει τις αλλαγές. 

 

Να θυμάστε ότι: 

 
 Η επιλογή Undo σε Edit Mode έχει αποτέλεσμα μόνο για το τρέχον αντικείμενο. 
 Τα δεδομένα μετά την αναίρεση δεν χάνονται όταν βγείτε από την κατάσταση Edit Mode, αλλά όταν 

εισέλθετε σε Edit Mode για διαφορετικό αντικείμενο. 
 

Στην κατάσταση Object ισχύουν οι ίδιοι συνδυασμοί πλήκτρων Ctrl+Z για undo, ⇧ Shift+Ctrl+Z για redo. 

Αν κάνατε αλλαγές σε Edit Mode και δεν χάθηκαν, τότε όλες οι αλλαγές θα αναιρεθούν αν πατήσετε το 

συνδυασμό Ctrl+Z σε Object Mode. 
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Κορυφές που συμπίπτουν 

 
Η εξώθηση (Extruding) λειτουργεί μόνο όταν έχουμε δημιουργήσει καινούριες κορυφές και μετά τις 

μετακινούμε. Αν κατά τη διάρκεια μετακίνησης πατήσουμε Escape ή κάνουμε δεξί κλικ τότε οι νέες 

κορυφές θα παραμείνουν και θα τοποθετηθούν πάνω από τις αρχικές, οπότε θα έχουμε διπλότυπα. Ο 

απλούστερος τρόπος να αναιρέσουμε αυτό το λάθος είναι ο συνδυασμός Undo (Ctrl+Z). Καμιά φορά είναι 

χρήσιμο να δημιουργούμε πρώτα τις κορυφές και μετά να τις μετακινούμε, κλιμακώνουμε ή περιστρέφουμε 

με τα πλήκτρα G,S ή R. 

 

Συνεχίστε την εξαγωγή κορυφών με τον ίδιο τρόπο μέχρι να 

κατασκευάσετε το σχέδιο του διπλανού σχήματος. Για να 

επιτρέψετε την ελεύθερη κίνηση τμημάτων, πατήστε το μεσαίο 

πλήκτρο του ποντικιού (MMB ) αφού έχετε πατήσει το 

πλήκτρο E και πριν κάνετε αριστερό κλικ (LMB ). Αν δεν το 

κάνετε αυτό, τα πόδια θα καταλήγουν ευθεία προς τα κάτω κι 

όχι πλαγιαστά. Επίσης, για να μπορέσετε να μετακινήσετε 

πλάγια και τις δύο κορυφές της κάτω ακμής, χρειάζεται να 

απενεργοποιήσετε προσωρινά την επιλογή X axis στον mirror 

modifier, να φτιάξετε το σχέδιο και μετά να την 

ενεργοποιήσετε ξανά. Για την ακριβή τοποθέτηση των νέων 

τμημάτων, έχετε πατημένο το πλήκτρο Ctrl όσο τα μετακινείτε. 

 

Σε αυτό το σημείο θα έχουμε τελειώσει με το μοντέλο 

καθρέφτη, Για να φτιάξουμε στην πραγματικότητα το μοντέλο 

καθρέφτη, θα πρέπει   να εφαρμόσουμε τον τροποποιητή, 

κοινώς να πατήσουμε το κουμπί apply ώστε να εφαρμοστούν οι αλλαγές που κάναμε. Με τον χαρακτήρα 

μας, τον Gus, σε κατάσταση Object (πατήστε ⇆ Tab αν βρίσκεται σε Edit Mode), πατήστε στο κουμπί 

Apply του Mirror modifier. 
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Σχεδιάζοντας το κεφάλι 

 
Μεταβείτε σε Edit Mode (πατήστε ⇆ Tab αν βρίσκεστε σε object mode) 

 

Μετακινείστε το δείκτη του ποντικιού ακριβώς ένα τετράγωνο από το σώμα του Gus. Για να τοποθετείστε 

τον κέρσορα σε ένα συγκεκριμένο σημείο του πλέγματος, κάντε αριστερό κλικ κοντά στο σημείο που 

θέλετε να τοποθετηθεί και πατήστε το συνδυασμό ⇧ Shift+S για να ανοίξετε το Snap Menu. Η επιλογή 

Cursor to Grid τοποθετεί τον κέρσορα ακριβώς στο σημείο πλέγματος (αυτό επιθυμούμε τώρα), ενώ η 

επιλογή Cursor to Selection τοποθετεί τον κέρσορα σε επιλεγμένο αντικείμενο. 

 

Για να φτιάξετε το κεφάλι του χαρακτήρα μας επιλέξτε Shift+A >> Add >> Cube ( αριστερή εικόνα στο 

σχήμα) . 
 

 

 

 

Πατήστε G για να μεταβείτε σε Grab Mode και να μετακινείστε το νέο αντικείμενο προς τα κάτω. Μπορείτε 

να περιορίσετε την κίνηση σε ευθεία γραμμή πατώντας το μεσαίο πλήκτρο του ποντικιού. Μετακινείστε τον 

κύβο κατά περίπου 1/3 της μονάδας και κάντε αριστερό κλικ για να "κλειδώσετε" τη θέση του (δεξιά εικόνα 

σχήματος). 

Δημιουργία αντικειμένου 
 

Όταν προσθέτετε ένα αντικείμενο σε Edit Mode για ένα άλλο, το νέο αντικείμενο γίνεται μέρος του υπάρχοντος. 

Έτσι, ο κύβος που εισάγαμε ενσωματώθηκε αυτόματα στη σχεδίαση του κορμιού που έχουμε κάνει. 
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Υπο-επιφάνειες (SubSurfaces) 
 

 

 

Subsurf modifier 

 
Για το επόμενο βήμα, χρειάζεται να επιλέξουμε όλα τα μέρη του χαρακτήρα μας κι όχι μόνο το κεφάλι (  

χρησιμοποιήστε το πλήκτρο A - ίσως παραπάνω από μία φορά). 

 

Μέχρι τώρα έχουμε φτιάξει ένα απλοϊκό σχήμα. Για να το κάνουμε πιο απαλό επιλέξτε το περιεχόμενο 

τροποποιητών ( Modifier context) και προσθέστε έναν Subdivision Surface modifier (The Subsurf modifier). 

Σιγουρευτείτε ότι έχετε ορίσει τα κουμπιά View και Render σε τιμές μεγαλύτερες ή ίσες του 2. Η επιλογή 

View ορίζει το επίπεδο υποδιαίρεσης που θα εμφανιστεί στη σχεδίαση 3D ενώ η επιλογή Render ορίζει το 

επίπεδο υποδιαίρεσης κατά την απόδοσης της τρισδιάστατης γεωμετρίας. 
 

 
 

Για να έχετε την αίσθηση αυτής της ιδιότητας, μεταβείτε στην Edit Mode (⇆ Tab) στην επιλογή Solid 

display mode πατώντας το πλήκτρο Z . Ο χαρακτήρας μας θα μοιάζει κάπως έτσι). 
 

Υποεπιφάνειες (SubSurfaces) 
 

Οι υπο-επιφάνειες είναι ένα προηγμένο εργαλείο μοντελοποίησης, το οποίο εκλεπτύνει δυναμικά λεπτομέρειες σε 

ένα τραχύ δίκτυο ακμών. Η ιδέα λειτουργίας του έγκειται στη δημιουργία ενός πιο πυκνού δικτύου ακμών και στον  

εντοπισμό τον κορυφών του ώστε να ακολουθεί πιο εκλεπτυσμένα τη γεωμετρία του αρχικού σχήματος. 
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Για να κάνουμε το αντικείμενο να δείχνει ακόμη πιο λείο πατήστε το πλήκτρο 

Smooth, το οποίο βρίσκεται κάτω από την επιλογή Shading στην εργαλειοθήκη 

Tool Shelf του παραθύρου 3D Window (T). Ο Gus θα διαθέτει τώρα πιο απαλή υφή, 

παρόλο που πιθανώς να έχει μαύρες γραμμές στη μέση του σώματός του. Η 

ελαττωματική αυτή απεικόνιση θα έχει αποφευχθεί εάν έχει χρησιμοποιηθεί σωστά 

η λειτουργία του Mirror modifier και προέρχεται από τη μετακίνηση και την 

αναδίπλωση επιλεγμένων κορυφών. Οι γραμμές αυτές εμφανίζονται επειδή το 

δίκτυο κορυφών που χρησιμοποιεί ο SubSurf' modifier υπολογίζεται λαμβάνοντας 

πληροφορία από το αρχικό δίκτυο κορυφών του τραχέος αντικειμένου, το οποίο 

πιθανώς να μην είχε κατασκευαστεί σωστά με όλα τα σημεία τοποθετημένα στη 

σωστή κατεύθυνση. Για να ορίσουμε πιο σωστά τις αρχικές κατευθύνσεις 

υπολογισμού επιστρέψτε σε Edit Mode (Tab), επιλέξτε όλες τις κορυφές (A), και 

πατήστε Ctrl+N. Τώρα ο Gus θα πρέπει να εμφανίζεται με μεγαλύτερη ακρίβεια . 

Πατήστε το μεσαίο πλήκτρο του ποντικιού και σύρετε το ποντίκι σε διάφορες 

κατευθύνσεις ώστε να κάνετε προεπισκόπηση της σχεδίασης από όλες τις γωνίες 

θέασης. 
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